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The Preparation of Nutrient Analyser (NAS-3X) for
Deployment:

Issue 4

1 Introduction

Effective marine monitoring is vital for the accurate assessment of
environmental change. In response, Cefas has developed SmartBuoy: a cost
effective, high frequency, multi-parameter data acquisition platform.
SmartBuoy’s instrument package includes Nutrient Monitor (NAS): a
submersible in-situ nitrate analyser, designed and manufactured by
EnviroTech LLC. Nutrient Monitor uses conventional wet chemistry
techniques and colorimetric detection.

2 Scope

This SOP describes the procedure for the deployment preparation (including
calibration) of Nutrient Analyser (NAS-3X). It does not include servicing of
NAS-3X (see SOP SMO001). All files required in this procedure are located on
SmartBuoyOps$ shared drive and are mirrored on the local C: drive of both
SmartBuoy Team laptops.

3 Training (Identify any specific training linked to the SOP)

This procedure may only be carried out by staff who have received
training in this SOP. Training records must be maintained and archived
accordingly.
The operator should refer to ‘NAS-3X Nutrient Analyzer Operating Manual’
(SmartBuoyOps$>Sensors and Instruments>EnviroTech Instruments>Nas-
3X>Manuals>nas3xman) for further details of the procedure described in this
SOP.
Training records must be maintained and archived accordingly.

4 Safety Precautions

Before performing this procedure staff should have read and understood
the following COSHH & risk assessments.

4.1 COSHH

MPM-MAS-MOS-COSHH-108 Reagents for NAS-3X in-situ nitrite
analyser (080725)

4.2 Risk Assessments

5 References/Associated documents

The operator should refer to ‘NAS-3X Nutrient Analyzer Operating Manual’
(SmartBuoyOps$>Sensors and Instruments>EnviroTech Instruments>Nas-
3X>Manuals>nas3xman) for further details of the procedure described in this
SOP.
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6 Equipment /Apparatus
1. Nutrient Analyser NAS-3X with communications and battery cables
2. Reagents and OTCR prepared for deployment
3.  PC with serial port, ‘NutrientDATA2’ and ‘“Tera Term Pro’
4. BBP10 battery housing and full pack
5.  PVC clamp set
6. Transport frame
7. Gaffer tape
8. Cable ties
9. Side cutters
10. Metric Allen key set
11. Spanners (13 mm, 17 mm)
12. O-ring fitting tool
13. Plastic tray
14. 2 x 125 ml beakers
7 Ingredients/Reagents/Media
8 Procedure

NAS-3X Preparation

This procedure should be carried out in conjunction with the sheet titled ‘NAS-
3X Checklist’ and the NAS calibration check located:
SmartBuoyOps$>Administration>Templates>NAS>. The calibration Check
should be printed on the back of the checklist. In the following procedure, any
text within speech marks (“’) should be typed without the speech marks.

1. Check instrument has been serviced since last deployment.

Check instrument has been serviced since its last deployment by checking
service history; see (SmartBuoyOps$>Sensors and Instruments>Service
History>NAS>NASX...).

2. Ascertain details required to set up NAS.

a. Run ‘NutrientDATA2’ from shortcut on desktop or
Start>Programs>EnviroTech LLC>NutrientDATA2.

b. Select ‘Script Designer.’

Open ‘File’ menu and select ‘Open.’

d. Use ‘Look in:’ drop down menu to locate ‘NAS-3X OTCR NO3 Script
Set’ project found: SmartBuoyOps$>Sensors and
instruments>EnviroTech Instruments>NAS-3X>Scripts>NAS-3X OTCR
NOS Script Set. Left click once to select file then click ‘Open.’

e. Select ‘Description’ from list on left hand side of screen and look up
‘Intensity’ value for instrument.

0o
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f. Note Intensity on NAS CALIBRATION CHECK sheet.

g. Open ‘Work plan LATEST.xIs’ found: SmartBuoyops$>Administration
and ascertain deployment length expected (in days), including pre-
deployment time, from ‘x DEP INFO’ sheet (where X is the site name).

h. Note deployment length +14 on NAS CALIBRATION CHECK sheet.

i. Open ‘NAS Reagent Budgets’ sheet in same workbook. Look up
deployment length +14 ascertained in g to find sample interval.

J.  Note sample interval on NAS CALIBRATION CHECK sheet.

3. Prepare NAS reagents.

See ‘NAS-3X Reagent prep SOP SMO003
(SmartBuoyOps$>Administration>SOPs>...)

4. Prepare OTCR reagents.

See ‘Preparation of cadmium column for NAS-3X in-situ nitrate analyser
SOP’

(SmartBuoyOps$>Administration>SOPs>...)

5. Fit reagents into reagent housing.

a. Fit reagents into reagent housing of instrument. Ensure all outlet tubes
of reagent bags are pulled fully through and that there are no kinks.

b. Each reagent should be fitted so that it's above the port it will be
connected to: imidazole (1.8l) to purple, imidazole (1.2l) to brown,
NEDD to yellow, sulphanilamide to orange and OBS to green.

c. Make a note of OBS label in appropriate comments box on Checklist,
NAS CALIBRATION CHECK sheet & in black book.

d. Place a sample of the OBS in a small plastic pot for analysis of TOxN
concentration by the nutrients laboratory. Place the pot for analysis in
the fridge and inform the nutrient laboratory manager. Label the OBS
with the original name

e. Connect reagent bags to connector tubes (form a kink in reagent bag
outlet tube, remove blue stopper and screw into connector tube).

6. Connect pre-deployment standard (PDS) to sample inlet (grey). Place
waste outlet tube (from colorimeter) into empty container. Note PDS label &
concentration on checklist.

a. Cable tie EVA bag containing PDS to top of reagent housing.

b. Remove blue stopper and connect to sample inlet. (Grey port)Note
PDS label and concentration on Checklist NAS CALIBRATION CHECK
sheet & in black book.

c. Place a sample of the PDS in a small plastic pot for analysis of TOxN
concentration by the nutrients laboratory. Place the pot for analysis in
the fridge and inform the nutrient laboratory manager. Label the PDS
with the original name.
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7. Activate OTCR. Connect to red port adaptor. Attach filter to open end and
immerse in container of imidazole buffer.

a.

d.

Fit OTCR inlet tubing (short piece) to red port adaptor on instrument.
Ensure tubing is pushed fully onto port adaptor and that the tube is not
kinked to allow clear passage of liquid.

Secure OTCR to instrument pillar with two cable ties.

Place OTCR vent tube in a container filled with imidazole buffer,
ensuring filter is completely submerged. Note: it is important to
completely submerse the filter in imidazole buffer to prevent air being
drawn into the OTCR.

Open the pinch clip.

8. Make up new battery and check voltage (V). Note reading and housing S/N.

a.
b.
C.

Remove three screws from battery housing.

Remove lid from battery housing and disconnect wiring.

Replace old battery pack with new one. Old battery should be retained
if voltage >12 V.

Remove o-ring from battery housing lid.

Clean and check o-ring. Clean and check groove and sealing surface
of battery housing lid.

Clean sealing surface of battery housing.

Apply thin film of silicone grease to o-ring and refit to battery housing
lid.

Refit lid to battery housing. Refit three screws.

Measure battery voltage. Note reading in comments box on service
sheet. Label battery housing with instrument serial number, voltage,
date and deployment. Record voltage on the ‘Battery Voltage’ sheet in
the workbook ‘Work plan LATEST
(SmartBuoyOps$>Administration>Work plan LATEST)

9. Connect instrument to PC, run NutrientDATA2, set sample interval and
colorimeter intensity value then upload scripts.

a.
b.

Connect instrument to serial port of PC via comms. cable.

Connect instrument to battery cable and place cable next to battery.
Remove blanking plug from battery but do not connect cable to battery.
Run ‘NutrientDATA2’ from shortcut on desktop or
Start>Programs>EnviroTech LLC>NutrientDATAZ2.

Select ‘Script Designer.’

Open ‘File’ menu and select ‘Open.’

Use ‘Look in:’ drop down menu to locate ‘NAS-3X OTCR NO3 Script
Set’ project found: SmartBuoyOps$>Sensors and
instruments>EnviroTech Instruments>NAS-3X>Scripts>NAS-3X OTCR
NOS Script Set. Left click once to select file then click ‘Open’.

SOP SMO004 Issue 5 Page 7 of 13



SOP SMO005 Augl10
Laboratory 046

Select ‘Settings’ and enter sample interval ascertained in 2. i and
‘Intensity’ ascertained in 2. g. Click ‘OK.’

Plug battery cable into battery.

From ‘Scripts’ menu select ‘Upload current project’ then click ‘Yes.’ If
prompted to enter a password, type “password” and press <enter>
twice.

When scripts have uploaded (5 files), click ‘OK.’

Note: it is necessary to re-upload scripts every time NutrientDATA2 is
closed and reopened.

10. Run priming script (Prime(P)).

a.

In ‘NutrientDATAZ2,’ left click once on ‘Prime(P)’ script to highlight this
script.

In ‘Scripts’ menu, select ‘Test current script.’

Enter “1” for number of repetitions and click ‘OK’ to run the priming
script. The reagent lines will be purged of air.

When script is complete click ‘Close.’

11. Run Standard(T) script.

a.

b.
C.
d.

In ‘NutrientDATAZ2,’ left click once on ‘Standard(T) script to highlight
this script.

In ‘Scripts’ menu, select ‘Test current script.’
Enter “1” for number of repetitions and click ‘OK.’
When script is complete click ‘Close.’

13. Perform bench calibration.

N.B.

Keep an eye on the Imidazole and waste containers whist

performing the bench calibration, remove some imadazole using a
syringe and empty the waste container as necessary.

a.

b.
C.

= Q

Open the file ‘DEPLOYMENT_NAS WMS QA’ located:
SmartBuoyOps$>Administration>Templates>NAS>.

Fill in details in ‘Deployment’ and NAS serial#

Save file in appropriate deployment folder
(SmartBuoyOps$>Data>Active SmartBuoy moorings>'Site’>’Deployment
Folder’) and name the file: DDD_NNN _NAS_WMS QA, where DDD =
site, NNN= deployment number.

Prepare bench standards. Take small bench standard bottles from the

fridge. Empty the bottles into sink. Rinse with a small amount (5ml) of
corresponding bench standard from the 1| bottle from the fridge. Decant
50ml approx (to the line on the small bottle) from the 11 bottle.

In ‘NutrientDATAZ2,’ left click once on ‘Standard(T)’ script to highlight this
script.

In ‘Scripts’ menu, select ‘Test current script.’
Enter “3” for number of repetitions and click ‘OK.’
When the script has finished, Scroll up to the top of the script.
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Scroll down to find the line “RECORD DATA READING 1 ‘[Bt-NO3J.
Copy the two 5 digit numbers after the 4™ comma on from the line below
into the cells labelled Bt-NO3 on the Calibration checksheet. Scroll
down to find the line “RECORD DATA READING 1 ‘[Rt-NO3J'. Copy the
two 5 digit numbers after the 4™ comma on from the line below into the
cells labelled Rt-NO3 on the Calibration checksheet.

Continue to scroll down through the script and record each of the
readings for all three analyses.

click ‘Close.’

In ‘NutrientDATAZ2,’ left click once on ‘Sample(S)’ script to highlight this
script.

In ‘Scripts’ menu, select ‘“Test current script.’

. Enter “3” for number of repetitions and click ‘OK.’

When the script has finished, Scroll up to the top of the script. Scroll
down to find the line “RECORD DATA READING 1 ‘[Bs-NO3]’. Copy the
two 5 digit numbers after the 4™ comma on from the line below into the
cells labelled Bs-NO3 on the Calibration checksheet. Scroll down to find
the line “RECORD DATA READING 1 ‘[Rs-NO3]'. Copy the two 5 digit
numbers after the 4™ comma on from the line below into the cells
labelled Rs-NO3 on the Calibration checksheet.

Continue to scroll down through the script and record each of the
readings for all three analyses.

click ‘Close.’

Disconnect PDS from ‘GREY’ port

Place sample inlet tube (from the Grey port) into a bottle of bench
standard (any concentration)

In ‘NutrientDATAZ2’, left click once to select ‘Standard(T) then select
‘Scripts’ menu followed by ‘Test current script.’

Enter “1” for the number of repetitions and click ‘OK.” One analysis of
the OBS will be performed and takes around 10 minutes.

Scroll up to the top of the script.

Scroll down to find the line “RECORD DATA READING 1 ‘[Bt-NO3J.
Copy the two 5 digit numbers after the 4™ comma on from the line below
into the cells labelled Bt-NO3 on the Calibration checksheet.

Scroll down to find the line “RECORD DATA READING 1 ‘[Rt-NO37J.
Copy the two 5 digit numbers after the 4™ comma on from the line below
into the cells labelled Rt-NO3 on the Calibration checksheet.

Click ‘Close.’

In ‘NutrientDATAZ2’, left click once to highlight ‘Sample(S),” then select
‘Scripts’ menu followed by ‘Test current script.’

Enter “3” for number of repetitions and click ‘OK.” Three analyses of
sample will be performed taking around 30 minutes.

aa. In ‘NAS Calibration’, using the readings obtained in V" and 7, fill in the

calibration data sheet in the cells indicated on the Calibration
checksheet.

bb. Scroll up to the top of the script.
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cc. Scroll down to find the line “RECORD DATA READING 1 ‘[Bs-NO3J.
Copy the two 5 digit numbers after the 4™ comma on from the line below
into the cells labelled Bs-NO3 on the Calibration checksheet.

dd. Scroll down to find the line “RECORD DATA READING 1 [Rs-NO3]J.
Copy the two 5 digit numbers after the 4™ comma on from the line below
into the cells labelled Rs-NO3 on the Calibration checksheet.

ee.Continue to scroll down through the script and record each of the
readings for all three analyses.

ff. Click ‘Close.’

gg.Place sample inlet into another bench standard and repeat steps f — u.
Repeat for remaining standards.

hh.In ‘DEPLOYMENT_NAS_WMS QA’, using the readings obtained in ‘p’
and ‘q’, fill in the calibration data sheet in the cells indicated on the
Calibration checksheet.

ii. When calibration is complete, close ‘Script Designer window. Click
‘Yes’ to save changes.

jl-  View graph on ‘Plot (to 75uM)’ tab
kk. Enter instrument serial number, date and deployment in graph title.
[l.  Check graph is linear over required concentration range.

14. Run TeraTermPro and extract calibration data. Save data to notepad file
and locate in deployment folder.

Open ‘Tera Term Pro.’

Press <enter> to display command prompt.

Type “extract /store/flash/data, graph”. Press <enter>.

Use scroll bar to scroll up to start of calibration data.

Hold down left mouse button and drag down to select all the data.
Go to ‘Edit’ menu and select ‘Copy.’

Open ‘Notepad’ (Start>All Programs>Accessories>Notepad).
Open ‘Edit’ menu in ‘Notepad’ and select ‘Paste.’

In ‘Notepad’ select ‘File’ menu then ‘Save As...” Save file in deployment
folder instrument will be used on, located:
SmartBuoyOps$>Data>Active SmartBuoy
moorings>'Site’>'Deployment Folder’>’NAS’. Use filename format: nas
X calibration Y Z, where X = serial number of instrument, Y= site (e.g.
liv bay) and Z= deployment number.

j- Unplug instrument from battery.

k. Note ‘Notepad’ filename on Checklist.

T S@ o0 o

15. Run NutrientDATAZ2 and reset memory.

a. Open ‘NutrientDATA2’ and select ‘Data Processing.” Note: ensure
‘Tera Term Pro’ is closed.

b. Plug instrument into battery.
Select ‘Clear’ then ‘Yes.’ Enter “password” if prompted for a password.
d. Select ‘OK’ when complete, then close NutrientDATA2.

0o
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16. Fit guard and reagent housing lid. Secure reagent bags with cable ties.

oo

Unplug power and comms. cables from instrument.

Close pinch clip on OTCR vent tube.

Remove waste tube, OTCR vent tube and sample inlet tube from
liquids.

Remove PDS.

Fit guard ensuring reagent lines do not become kinked and sample
inlet, OTCR filter and waste tube protrude through hole. Fit the
securing screws.

Cable tie the reagent bags to the reagent housing lid and fit the screws.
Tape Fritware® filter to reagent housing lid with gaffer tape.

17. Fit instrument and battery to sub-frame. Note battery S/N.

a0 op

Fit the three clamps to sub-frame.
Fit sub-frame to transport frame.
Fit instrument and battery to sub-frame.

Note battery serial number and power cable number on Checklist.
Record on the ‘Battery Voltage’ sheet in the workbook ‘ Workplan
LATEST (SmartBuoyOps$>Administration>Work plan LATEST)

18.Immerse filter end of OTCR tubing in container filled with imidazole buffer,
fit waste container and connect PDS to sample inlet.

a.

b.

o

e.

f.

Rest a plastic tray on lower instrument clamp immediately below tubes.
Secure tray with gaffer tape.

Place one empty plastic container and one half filled with imidazole
buffer.

Place waste tube in empty container.

Place OTCR vent tube in container filled with imidazole and open pinch
clip. Ensure filter is completely submerged. Note: be sure to open
pinch clip.

Secure PDS to reagent housing lid with a cable tie.

Connect PDS to sample inlet.

19. Run TeraTermPro, set instrument clock (GMT), set delayed start and set
instrument to run. Note instrument start time.

Qo ow

Connect instrument to comms. cable and battery.

Open ‘Tera Term Pro’ and press <enter> to display command prompt.
Type “time” <enter>.

Use “setdate” and “settime” commands to adjust time to GMT if
necessary.

Open ‘Start times’ in the workbook ° Workplan LATEST
(SmartBuoyOps$>Administration>Work plan LATEST) Ascertain
possible start times given sample interval instrument will be running.
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The start time should be approx 48 hours before the instrument is to be
deployed.

Return to ‘Tera Term Pro,’ type “cd flash” and press <enter>.

Type “cd scripts” and press <enter>.

At ‘Admin:/store/flash/scripts> command prompt type “edit main.eco”
and press <enter>.

Use the <cursor> keys to navigate to line containing the ‘waituntil’
command and edit time and date to equal to that ascertained in e.

Hold <ctrl> and type “e”. Type “y”.

At ‘Admin:/store/flash/scripts> command prompt type “main.eco” and
press <enter> to execute the script.

Unplug comms. cable from instrument and fit blanking plug.

m. Cable tie battery cable to sub-frame.

Make a note of the start time and date on the checklist and start time,
date and sample interval on a ‘post-it note’ on the instrument.

20. Record preparation

a.

Save completed Checklist in appropriate deployment folder
(SmartBuoyOps$>Data> Active Smartbuoy
moorings>>'Site’>’Deployment Folder) and name the file: NAS_ X
CHECKLIST_Y_ Z, where X= serial number of instrument, Y= site, Z=
deployment number. Take a paper copy of the Checklist to sea with the
instrument.

Record instrument status on whiteboard.

Initial and date on work schedule sheet in
(SmartBuoyOps$>Administration>Work plan LATEST)

21.Fit instrument to SmartBuoy.

a.

b.

Check waste container contains pink liquid to be sure instrument has
started.

With the aid of an assistant, fit instrument to SmartBuoy frame using
four Nyloc M10 nuts and bolts.

22. Immediately prior to deployment, remove PDS and fit filter to sample inlet.
Note: this step should be carried out allowing enough time for the SmartBuoy
to be deployed before the next sample is taken.

a.

b.
C.

d.

Disconnect PDS from sample inlet tube and remove from reagent
housing.

Remove plastic tray and waste / imidazole containers.

Remove Luer connector from end of sample inlet tube. Fit Fritware®
filter to sample inlet tube.

Secure sample inlet and OTCR vent tubes to guard using cable ties.

Review

This procedure will be reviewed as a minimum on the time scales given in
the review / amendment programme. A record of the review will be made
on a separate Review / Amendment Sheet which will be added to the
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Master Copy file of this SOP. Any amendments arising from such review
or from operating requirements will result in the issue of the entire
amended procedure as a new Issue.

10 Records

This procedure, its review sheets and its subsequent revisions constitute
records in themselves and each master copy will be retained in a file as
arranged by the Quality Manager. Records will be retained for a minimum
of five years unless otherwise specified.

(List specific record sheets/books)
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